
The Photojournal of the Art Institute of Philadelphia
04.01  Summer 2008





SUBMISSION GUIDELINES
FOR PIQUE MAGAZINE 

PIQUE Magazine is currently accepting submissions for the Spring 2008 issue. 
This is a unique opportunity for students in the AIPH community to have their 
work professionally published. Photographs are accepted from all student 
majors, however they must adhere to the following guidelines for both images 
and text.

      IMAGES:

 Flattened (no layers)
 TIFF files only  
 CMYK only
 300 DPI
 Minimum size 9 by 12 inches (smaller images accepted for portfolio use)

      TEXT:

All images should be accompanied by text, such as an artist statement 
or photo story as well as phone and email contact information. Artist 
statements should be a minimum of 100 words and photo stories should be 
approximately 250-500 words. Please submit all text as a separate Microsoft 
Word document.

All .tif and .doc file submissions should include your full name and story name.
Ex: pique_ben_weger_selfportrait.tif, pique_ben_weger_selfportrait.doc

Submissions can be burned to either a DVD or CD. If you have any questions or 
are interested in any of the photographer’s work please contact PIQUE via email 
at: piquemagazine@gmail.com.

The editors and staff of PIQUE endeavor to present all images printed in their 
original, uncropped formats. There are times when some cropping occurs due to 
space and layout constraints. All written content is reviewed and may be edited 
or altered for space, grammer, comprehension or other reasons at the discretion 
of the magazine.    

Open an image to record the action operations.
Reduce the size of the image so that the longest side (height or width) is no  
larger than 10 inches. 
Click on the Actions pallet or open the Actions pallet through   
Window > Actions.
Click on the Create New Action button on the bottom and give it a name. 
Click to Image > Mode > CMYK.
Click to Image > Image Size.  Change the resolution to 300 dpi. Make sure 
that the “Resample Image” checkbox is selected.
Click to Edit > Convert to Profile. From the drop-down box, select “Adobe 
RGB(1998)”. Click OK.
Click to File > Save As... Change the format to TIFF. Click Save.
Actions pallet, click the Stop playing/recording button on the bottom left.
Verify your image has been saved correctly.
Open a new image and size it. On the Actions pallet, click on Pique, then 
click the Play button on the bottom. This should perform all of the actions 
you recorded and make any future magazine submission process easier.

FROM THE PIQUE STAFF
Make your submission process easier! Create an Action Set  
in Photoshop.
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EDITOR’S NOTE
BEN MACMASTER

pring is often a symbol of life, renewal, and rebirth. Every 
year plants come back from a temporary hibernation, 

continuing the circle of life by dropping new seeds. In 
celebration of this rebirth and renewal, Pique has, in a way, 
transformed itself. There are many articles throughout this 
issue with full-page bleeds and overall the quality of the 
images, and the work as a whole, has allowed us to go corner 
to corner. As the new Co Editor-in-Chief, I am proud of the new 
direction that Pique has taken. 

These past few quarters have been full of change, not just 
with Pique, but also with our school. I am personally pleased 
to finally see recycling bins throughout the school since in the 
past there has been trash can after trash can full of recyclable 
materials. It is about time that our school, and our city, has 
taken notice of the growing environmental concerns and 
problems which we all will face in the future.

Speaking of the future, Pique will soon be available online at 
our school’s blogspot (www.aiphphotography.blogspot.com). 
This blogspot will allow anyone with access to the internet to 
view our magazine page by page. 

S So by submitting work, you not only will be published in a 
magazine, but your work will also be online. This is a great new 
way to get exposure. 

To continue this trend of change and development, I am taking 
this opportunity to announce something new for the next issue 
of Pique. We are planning to publish a special edition of Pique 
in black and white. All of the normal guidelines apply, the only 
new requirement is that the images are black and white. This 
upcoming issue will celebrate one hundred and seventy years 
of photography, so go out and start shooting and submit your 
best black and white work.

PhOTOGRAPhY blOG
www.aiphphotography.blogspot.com

PIQUEONLINE



07

ED
ITO

R’S N
O

TE 
BEN

 M
A

C
M

A
STER 

 
 

 
 

 
 

 
 

 
PIQ

U
E SPRIN

G
 2008



FACES OF CANCER
ASHLEY BAKER

Breast cancer affects 
just about every family 

in the United States.

T his body of work shows the faces of breast cancer 
survivors through the portraits of real women who 

have been diagnosed with the disease. These portraits are 
hyper-real images that show every honest flaw of the skin, 
which helps to translate the impact that breast cancer 
has had on these women, and others like them.  

Breast cancer affects just about every family in the United 
States and after my Aunt Marcia passed away following 
a forty year battle, I really wanted to do something to 
increase awareness.  

These portraits draw the viewer’s attention directly to the 
women’s spirit, and the sharp skin textures add insight 
into their unique characters.  These photographs were 
intentionally shot close and in the personal space of these 
women because they are representing the blunt reality of 
living with cancer

My intent is to promote breast cancer awareness, and 
with the help of these women who were willing to sit in 
front of my camera, maybe together we have encouraged 
one or two women out there to realize how important early 
detection and awareness really are. 

For more information about this disease go to 
www.komenphiladelphia.org. 
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PLAYING MEMORY
ALLISON OLSZEWSKI

The photographs are just as much about the art of 
exploring the old stomping grounds of my childhood as 
they are my exploration of new art forms in the medium 
of photography. 

As a body of work, they come together to form the 
memory of my past as a little girl with no worries in 
the world, other than the thought of having to leave the 
playground early.

I wanted to create  
images that had a  

whimsical, memory- 
like look.

laying Memory is a series of photographs that I 
created to remind me of my childhood growing up 

having fun on playgrounds. This is the first series I have 
done where I had full reign to decide what I wanted the 
subject to be and how I wanted to create it. So I thought 
outside the box and wanted to create images that had 
a whimsical, memory-like look and feel. To achieve the 
look of the blur and haze, I put Vaseline on my lens filter 
covering almost the whole thing, aside from some edges, 
and when the sun hit the lens, it flared. When I think 
about the past and my childhood, I get a playful feeling 
inside, and the images do just that when I look at them. 

I was very observant while photographing the playground 
sets because I wanted to get the perfect angle and 
composition. Once I saw the images together, they 
worked perfectly as little groupings, diptychs, and 
triptychs. I put the images together by categories, such 
as the jungle gym bars, spiral slides, horse rockers, and 
blacktop games like hopscotch and such. 

P
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CENTRALIA
CHRISTOPHER CAFOLLA

entralia, Pennsylvania is a forgotten town. Once home 
to over 2000 residents within the city limits and several 

who lived outside those limits, it is now home to as few as 
nine. The reason for this exodus from the city is an almost 47 
year old underground mine fire. This fire has caused adverse 
effects to the health of the residents and the necessity to 
reroute roads that once ran through the industrial borough.

The fire started in May 1962 when the borough council hired 
five members of the volunteer fire company to clean up the 
town landfill located in an abandoned strip-mine next to the 
Odd Fellows Cemetery. This had been done before Memorial 
Day every year, however, prior to 1962 the landfill was located 
in a different place. As they had in the past, the firemen set 
the dump on fire,  let it burn for awhile, and then put it out, or 
so they thought.

The fire continued to burn through the remaining trash. It 
burned through a hole in the rock pit into the abandoned 
coal mines beneath the city, and hit an eight-mile vein 
of coal, that contained enough coal to fuel it for roughly 
250 years.

This town is an example of a major environmental failure 
of our time. The tragedy that is Centralia Pennsylvania 
has sparked major concern for both mining procedures, 
and trash disposal methods. We no longer find it 
commonplace to burn trash, and mining is now done 
much more carefully. This town was not only a tragedy, 
but it sacrificed itself for the greater good of humanity.

C
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This town is an
example of a major

environmental failure 
of our time.



PORTFOLIO
PHOTOGRAPHY MAJORS

COLLETE SNYDER

CHRIS ACKRIVO



RYAN MILLBURN



KACIE BERNSTIEL
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TYLER GATES

ROB PATTERSON

ELMER RAMIREZ



FROM DAWN TO DUSK
JORDANA STURARO





I look for the moments 
in time that most 

people will never see, 
not care about, 

or take for granted. 

STREETVIEW
MICHAEL VAKSMAN

n Image of Philadelphia is a large collection of 
material that I began photographing in late 

October 2007. It is a continuous project that I decided 
to do while I still reside in the city of Philadelphia. The 
photographs are all street photography style, where 
nothing is posed. I set myself on a course for the day 
and just have fun exploring the city. Meanwhile, I look 
for the moments in time that most people will never 
see, not care about, or take for granted. I also try to not 
limit myself to the times when the weather is nice. My 
goal is to show an image of the city and this picture has 
many sides to it. The photographs are mostly all taken 
with a 35mm digital camera and a 50mm lens. They are 

A
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presented in black and white like the traditional street 
photographs of the past. I feel this is appropriate for my 
photos because nothing about them is truly absolute 
like the term black and white suggests.  

As for the individual images, they not only tell a 
story, but they have a story about how they were 
photographed as well. As the photographer I cannot 
deny that once I pick up my camera, I am now part of 
what I am photographing.  One image of a young boy 
feeding pigeons with his father in Penn’s Landing has a 
fun story behind it.  I asked the father without the boy 
knowing if I could photograph his son and he signed to 
me that it was fine for me to do so. He asked his son to 
smile and pose and I purposely only pretended to take 
pictures. After the boy was done posing, I made my way 
into the real position that I wanted to photograph from 
and waited for the exact moment that would express 
everything about the situation. I took three images 
consecutively to ensure that the moment was mine 
and then thanked them for letting me photograph them 
together. 

On the other hand, there are plenty of images where the 
subjects are not aware that they are being photographed.  
A few examples of these would be the woman walking 

past the bicycle parked on the sidewalk, the woman 
walking by the building full of different faces, and the 
people walking by the flag that was resting on the 
ground.  These images were all made by me composing 
my image and then waiting for the proper subjects to 
enter my frame so I could complete the photograph.

Another image  that I made was of a magician doing his 
routine on South Street. He was the main subject and I 
watched him for some time but I eventually decided to 
add someone from the crowd that had gathered around 
me into the image. To me the image was more about 
the people and what they felt about the magician than 
the magician himself. This photograph was captured 
somewhat differently than the one I made of a cook 
feeding pigeons out of the back of a restaurant kitchen 
door. He did not want to be in the picture and hid behind 
the kitchen door. I crept my way closer and got to an 
angle where I could see some of him peeking through 
the edge of the door. At the same his boss came out 
of another underground door and was yelling at me not 
to take pictures. This was the moment that I captured 
and it was a mix of skill, some good timing, and much 
needed luck.        
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SELF-MORTALITY
DANIEL HUTCHINSON

n this series of images, Daniel had chosen himself as the 
model to explore the thought of self-mortality. You will 

see images of Daniel dying in such ways as suicide by hanging, 
drowning, and being shot in the streets among others. These 
images were all photographied with a Mamiya RZ67 and the 
negatives were purposely distressed to give them a timeless, 
nineteenth century processing appearance.

Rather than describe the outward realities that have for so long 
fascinated photographers, Hutchinson has turned the camera 
and his vision inward – confronting and attempting to describe 
the intangible landscapes of his own emotions, fears, dreams and 
desires. Original in thought, in beliefs, and in the execution of 
his images, Daniel has succeeded in creating a unique series of 
short story-like pictures. 

“I’m interested in what happens when you die. I don’t know how 
you can be alive and not question that issue – I think that is a very 
reasonable question.” 

Many of the themes that Hutchinson photographs are issues 
that require a substantial level of soul searching, both on the 
part of the photographer and the viewer. And they present 
questions that are as difficult to ask as they are to try to 
answer: questions that can make people uncomfortable to 
confront. For Daniel, that different view was fueled by an 
insatiable curiosity. 

Hutchinson’s sequenced imagery, similar to the work of 
Michals and Gilles, present arrested moments in time, an 
interrupted continuity.

“Well, photographers are always photographing the 
package. But they would never think to open up the 
box. Well, I’m interested in the contents, because once 
you start opening up the box, it’s like a Chinese box. 
There’s always another box inside. So it is limitless. 
So, my version of reality means I believe in the tears.  
I believe in the reality of anxiety.”

I



rom February 4th to the 15th 2008 Professor Robert Cornelius of the Photography Department cruised the waters of Antarctica 
on the ship Le Diamant and made many images. During this time, eleven Zodiac landings were made on the continent and 

surrounding islands.  Antarctica is known as “al blanco deserto” in South America and is mainly various shades of whites and 
grays and darks. But on wonderful occasions the upper and lower spectrum of the rainbow 
are visible from the warmth of the sunset on a mountaintop to the extreme coldness of 
the icebergs and glaciers.  Many indigenous animals were sighted including three species  
of penguins (Adelie, Gentoo, and Chinstrap) and three species of whales (Minke, Killer, and 
Humpback).  For a further look at this expedition, a journal created by one of the naturalists 
aboard the ship has been placed in the public drives in 1610 and 1622 under the title – 
antarctica/cornelius.

THE WHITE DESERT
ROBERT CORNELIUS

F
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MC LARS
MIRANDA WATSON

W hen trying to finish up a project for 
photojournalism during my 7th quarter here at 

the Art Institute, I stumbled across a musician named, 
MC Lars, who I used for my final project. Little did I know 
that one show in Philadelphia on August 24, 2007 at The 
Trocadero would turn into a photographic adventure.

MC Lars, originally based out of San Francisco, California, 
has toured all over the globe and has no intention of 
slowing down. He has played shows in England, Japan, 
and Australia, where his single, Download This Song, 
made it to number twenty-nine on their top music list. I 
had the privilege of joining him on the last leg of his tour 
with the Aqua Bats, then his final show of the summer at 
Asbury Lanes in Asbury Park, NJ.

He has named his unique style, “post-punk-laptop-
rap,” relating to the use of his laptop on stage during 
performances. Not only does his laptop join him on stage 
but Rob Piccininni, bass/backup vocals, Jon Shiffman 
on drums, also accompany him sometimes, and Chris 
Ayer guitar/backup vocals, depending on the show. 
Along with the music, there is a projector and screen set 
up to show videos, clips that he thinks are funny during 
the breaks between songs, and even an intro to his song, 
Ahab, done by his mother.

Not only did I get a chance to document his performances 
on tour, I got to take stills on set during the production 
of his music video, Hipster Girl. This gave me the chance 
to see what else goes on in the world of music. The video 
was filming in the basement of a library that director 
Michael Licisyn and producer Tommy transformed into 
a production studio. I am happy that I got to be a part of 
this whole experience and hope to continue with it. 

This gave me the 
chance to see what 
else goes on in the 

world of music. 





PORTFOLIO
NON-PHOTOGRAPHY MAJORS

DANIEL OLSON

TIM NUGMANOV

JOHN INFERRERA

SANDY HUDDLE
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DANIEL OLSON

MARK EL-RAYES

TRACEY DALTON

TINA KNAPP
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DEVIN FRYMIRE

ALEC WERTHEIMER

TIM BERRY

SANDY HUDDLEDANIEL OLSON



BARE MINIMUM
NIESHA HUFF

n my opinion, the Philadelphia 
fashion scene leaves much to be 

desired. As a fashion photographer, 
living and shooting in the City of 
Brotherly Love, I’m constantly 
confronted with dirt and grime as I 
search for polish and sophistication. 
The scarcity of luxurious public 
locations, and limited supply of high 
fashion clothes in this area have 
turned an obstacle into an edgy 
style that I embrace.

For the majority of my photographic 
education, I chose to capture images 
in the studio to avoid the trash, 
street signs, broken glass and the 
homeless. But now I have begun to 
venture outdoors to shoot designer 
clothes in locations littered with 
debris and decay. The color clash 
of saturated city refuse against 
conservative figures, results in 
images that force the eyes into 
viewing more than just the clothes.

In my efforts to thwart the grunge 
of the city, I have learned to create 
with the bare minimum of resources. 
Abandoned properties, alleyways, 
and un-manicured backyards have 
become equally as valuable to me 
as ballrooms and stately houses. I 
now find myself scouting, in search 
of forgotten urban landscapes 
and residences. These pictures 
tell the story of chic individuals in 
unglamorous settings. Thank you 
to the models, stylist, and make- 
up artists Andrea Gaughan, Greg 
Taylor, Nora Alek, and Diana Garner 
respectively.

I



These pictures tell the 
story of chic individuals 
in unglamorous settings.
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T

BROKEN LEVEES
EDITORIAL STAFF

his past February, as the Philadelphia Flower Show 
celebrated the gardens of New Orleans, another vision 

of the “Big Easy” was on display at The Art Institute of 
Philadelphia from Associated Press photographer and Art 
Institute alumnus Rick Smith. “Broken Levees – New Orleans” 
was on display from March 5 through April 18, 2008 in The Art 
Institute of Philadelphia’s 1622 Chestnut Street Gallery.  An 
opening reception for the artist was held on Thursday, March 
6, 2008 during which students and faculty had a chance to 
meet the artist.

Six months after Hurricane Katrina and the following flood  
that devastated New Orleans, Bethlehem-based photographer 
Rick Smith packed up his antique wooden Deardorff 
8x10 view camera and traveled there to witness the story 
unfolding just beyond the celebration of the first post-Katrina  
Mardi Gras.

“The intense sense of shock from the devastation totally 
overwhelmed my vision for the first three days,” says Smith.  
“But on the fourth day I got to work.”   From the Lower Ninth 
Ward, one of the areas hardest hit by the storm, to the streets 
of the French Quarter, Smith sought out residents that were 
determined to survive and rebuild. 

Smith’s old-school film camera required him to build a sense 
of trust with his subjects as he painstakingly loaded the 
film in his tripod-set camera and arranged the upside-down 
image on the ground-glass lens.  Any sudden movement from 
his subject would require them to start all over again.  The 
resulting portraits show  a remarkable depth of feeling for their 
subjects.  

“All these people want is to have their story told,” says Smith,  
“because each and every one of them is dumbfounded at 
how the Katrina emergency was handled – or not handled.  
They wanted me to be a messenger for help – or at least 
understanding.” 

“The big story was the first Mardi Gras celebration after 
Katrina hit and how the city was bouncing back. My angle was 
not to document what was being seen, rather, to document 
what we didn’t see within the walls of the celebration. During 
the week-long celebration, just five minutes away, remaining 
residents were continuing their search for lost belongings, 
loved ones and answers, where do we go from here? Today, 
these questions are still being asked nearly two years after the 
levees have broken.”



DAVID ESSOM
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